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GENERAL

The licenses of these updates say, "You acknowledge and agree that Microsoft may automatically check the version of the OS Product and/or its components that you are utilizing and may provide upgrades or fixes to the OS Product that will be automatically downloaded to your computer."

In an interview, Windows Product Manager Charmaine Gravning said these terms are similar to "language in the EULA [end-user license agreement] for Windows XP," but she confirmed that they're new for Windows 2000.

She pointed to a recent Microsoft white paper documenting 11 components of XP that automatically download material from the Internet.

For example, XP's Media Player pulls down upgrades and then alerts you. If you have administrative privileges, you can click OK to install a newer player version. However, the app also downloads and installs newfound media codecs without any notice, if you've ever clicked the "always trust Microsoft" box while browsing the Web.

To disable such downloading, see the white paper at http://www.microsoft.com/WindowsXP/pro/techinfo/administration/manageautoupdate.
One thing you can't get around, however -- and a big reason for the latest fears -- is Microsoft's DRM (digital rights management) scheme. This built-in XP feature silently downloads and installs "revocation lists." These lists prevent "revoked" programs from playing DRM-encoded content.

The idea of giving any outside company the ability to remotely turn off something that previously worked on your computer strikes many as lunacy.

Aside from fair-use issues, users fear silent upgrades because Microsoft has pumped out many buggy patches that themselves needed patching. Just this June, Microsoft shipped the Nimda worm in its Korean edition of Visual Studio .Net.

Bruce Kratofil, my Windows 2000 Secrets co-author, describes patch pitfalls and ways to "take back XP" at http://www.bjkresearch.com/takeback.htm. He notes that Service Pack 3 conflicts with more than a dozen Windows 2000 hotfixes Microsoft sent out starting on July 23. (Go to http://search.microsoft.com, then search on Q326797.)

Kratofil is not alone. "The new Microsoft Win2K Service Pack 3 is a loser!" writes reader Christopher Shock. "It's ruined every machine I've installed it on so far (five), including our entire Web development staff and development server."

Fortunately, Shock recovered from backups, but he says Microsoft's user-discussion forums have been plastered with complaints from disgruntled users.

MEDIA
Disable Windows Media Player Spyware Features

Windows Media Player has more than its share of Spyware features. Fortunately, Palladium isn't here yet, so you still have some control over your personal computer. Check out these Spyware options and how to disable them: 

Open the Windows Media Player, click the Tools menu, and then click the Options menu. 

Click the Player tab. In the Automatic Updates frame, select the Once a month option. No need to risk the media player calling the mother ship if there's no compelling reason to do so. I'd also remove the checkmark from the Download codecs automatically. You might have issues playing some media types if you don't download the codecs, though. If you can't play certain media, turn it on and then download the codec. Then turn it off as soon as you get it. 

In the Internet Settings frame, remove the checkmarks from both the Allow Internet sites to uniquely identify your Player and Acquire licenses automatically checkboxes. You acquired your license when you bought the CD, you should be able to copy it to your hard disk. 

Click on the Media Library tab. On the Access rights of other applications frame, select the Read-only access. This theoretically would prevent DRM scumware products from molesting files you ripped from your legally purchased CDs. In the Access right of Internet sites frame, select the no access option. Do you really want Internet intruders reading your playlists and media files? Finally make sure to remove the checkmark from the Automatically add purchased music to library. When you buy your music, you should be able to put it wherever you like, and keep it away from the prying eyes of the media player. 

Keep a close eye on the Windows Media Player; this application appears to be the first brick in personal computing's road to Hell.
Whack the Windows XP Image Viewer

The Windows XP image viewer is anemic. You can't even copy and paste images from the image viewer to another program! If you have another image viewer, like Corel Photopaint, ACDSee, or any of the millions of other image viewers, you probably want to whack the default Windows XP Image Viewer. Here's how: 

Click Start and then click the Run command. 

Type cmd in the Open text box and click OK. This will open the command prompt. 

At the command prompt, type regsvr32 /u shimgvw.dll and press ENTER (no spaces in the filename). 

If you want to undo this change, just open the command prompt again and type regsvr32 shimgvw.dll and press ENTER (no spaces in the filename). 

You may have to manually associate image file types to your viewer after making this change.

Access Violation Error Message When You Right-Click MP3 Files

Life is getting rough for MP3 users. If it's not the media companies trying to lock you out of stuff you legally purchased, it's Windows XP giving you errors when you try to play them! Can we blame the dreaded Windows Media Player? Nope. This time it's the Microsoft PLUS! Pack that's causing the problem. If you have a problem right clicking on MP3 file, check out and download a fix here:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q311828
Playback of Some AVI Files Skips in Windows Media Player

You decide to brave the Windows Media Player and use it to play .avi files with it. When you play these files, especially when they're on a CD, they stutter and skip. What's up with that? There's a small problem with a filter used by Windows XP that can cause the buffer to act up. If you're having this problem, head on over to:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q327609
Transferring LPs and Cassettes to CD with Easy CD Creator 5 Platinum

We've spent a lot of time discussing how to get music copied to your computer from CDs that have been corrupted with copy protection schemes. But what about all that music you might have stored on LPs (anybody remember those?) and cassettes? There's a humungous amount of music out there stored in these "classical" formats that is waiting to be digitized and placed on your computer for safekeeping. Once you get that music onto your computer, you can then copy it to CDs to preserve your golden oldies for the long term. My thanks to Brian Papo for providing a link to the Roxio Web site where you can find complete instructions on how to transfer your record and cassette music to your computer. Check out the full details:

http://www.roxio.com/en/jhtml/error.jhtml
Stop Media from Automatically Playing in the Browser

Bill Collins, the "CableGuy," wrote in about a problem with playing media files. When he clicks links to movie files in the Internet Explorer, the movies end up playing in the media pane on the left side of Internet Explorer. He'd rather have the Windows Media Player pop up and play the file instead. No problem. Here's how to fix that: 

· Open Internet Explorer and click on the Media button in the button bar. 

· After clicking on the Media button, the Media bar appears on the left side of the Explorer. Look toward the bottom of the Media bar and you'll see where it says Media Options. Click on the Media Option command. 

· Point to the Settings command and then click on the Ask for Preferred Types command. 

Now you'll be asked if you want the videos played in the Media bar or in a separate Windows Media Player window
Bunches of FREE MP3 Converters

Last week we mentioned that we had a hard time finding free WAV to MP3 converters. Our WinXPnews readers came to the rescue. Here's a partial list of converters recommended by WinXPNews readers. We'll complete the list next week. 

Audacity : audacity.sourceforge.net
RazorLame : www.dors.de/razorlame/index.php
Right Click MP3 : my.execpc.com/~sfritz/rc-mp3
FreeRip : www.mgshareware.com/frmmain.html
SCMPX : download.com.com/3120-20-0.html?qt=SCMPX&tg=dl-2001
CDex : www.cdex.n3.net
MPEG Suite 2001 : ec2000.xperiment.net/index.php?id=software
Stream Box Ripper :www.sonicspot.com/streamboxripper/streamboxripper.html
dBpowerAMP : www.dbpoweramp.com
BladeEnc Site : www.mp3-converter.com/mp3_converter_freeware.htm
Be Careful -- MP3 Files May Contain Worms

Several weeks ago, we let you know about a problem with Windows Media Player (WiMP) that could allow an attacker to take over your computer. Since then, many of you have written to us about problems with your browsers opening up unexpectedly when playing audio or video files. Our best advice is that you play video files from trusted sources only and make sure your Antivirus and spyware detection programs are up to date. It has been rumored that the movie and music industries are putting poisoned files on file sharing sites. Those poisoned files could damage your computer's file system, causing you to lose all your data, so be very careful! For more information on WiMP and Winamp vulnerabilities, 
check out: http://www.wired.com/news/technology/0,1282,56924,00.html?tw=wn_ascii
NET, HTML, MAIL

Disable Windows XP Automatic Update

With Windows XP spyware coming down hot and heavy, it might be a good idea to wait on downloading fixes. Even if there's no spyware, you never know when a fix is going to hose your otherwise functional operating system. We've been nailed by a bad Windows XP fix a couple of times, and it's definitely no fun! You can always get new fixes at the Windows Update site, and you can pick and choose the updates you want. Just do the following to disable automatic update: 

Right click the My Computer icon on the desktop and click Properties 

Click the Automatic Updates tab 

Select the Turn off automatic updating. I want to update my computer manually option 

Click Apply and then click OK 

Restart your computer
Getting Java for Windows XP

I want to personally thank the over 100 readers who wrote in about the Windows XP Java problem. If you read last week's newsletter, Microsoft had to take down their Java Virtual machine because of some legal issues. But WinXPnews readers came to the rescue! First, you don't even have to use the Microsoft Virtual Machine, you can use Sun Microsystem's version, and it seems to work just fine. If you don't want to use the Sun version, you can download the Microsoft Virtual Machine. Both files are available at:

http://www.ddecirce.com/download/
Other places to get the file include: 

http://www.3danywhere.com/vm/
http://www.3danywhere.com/vm/msjavx86.exe
AOL install disk 

http://tinyurl.com/oca
The Morpheus installation program (http://www.morpheus.com/) 

http://www.tech-know-angel.com/winxp/msjavx86.exe
http://www.krm.com/techsupport/tech-downloads_mvm.html
http://cert.uni-stuttgart.de/ms-ie-updates.php
http://www.softwarepatch.com/windows/javavm.html
http://java.sun.com/j2se/1.3/download.html
http://www.netpumper.com/msjavx86.exe
http://java.sun.com/getjava/download.html
Or, try out Kevin Schoen's instructions:
"First go to this site and get the older version of the MS Virtual Machine:

http://www.mvision.mpsnet.com/java.htm
This will check for the basic VM and install an older version onto XP, and then you need to go to Microsoft and install the Java 4.0 SDK which will give you the newer base java components. You can get those from this link: Microsoft SDK for Java 4.0 for Windows 95/98, Windows Me, Windows NT 4.0, Windows 2000, and Windows XP or later:

http://download.microsoft.com/download/javasdk/install/4.0/win98/en-us/SDKJava40.exe
Once you have this installed and have re-booted your machine, then you need to go to the MS update site and install all the updates you do not currently have. The link to MS' site is:

http://v4.windowsupdate.microsoft.com/en/default.asp
When the updates are complete, you will need to re-boot one more time. After re-booting you will have the most current available Java for XP." 

Get Rid of Balloons Telling You to Sign up for Passport!

We have many requests for a tip on how to get rid of those irritating balloon tips that remind you to register Windows XP or get a Passport. Want to get rid of those "helpful" balloons? Then check this out: 

Click Start and then click the Run command. Type Regedt32 in the Open text box and click OK. 

Navigate to the following Registry key:

HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced 

Click the Edit menu, point to New and click DWORD Value. 

Rename the new value to EnableBalloonTips and press [ENTER]. 

The default value is 0 and you want to leave it that way. Close the Registry editor and restart the computer.
Click and Drag to make a New Home Page

Whenever you open your Web browser, your home page shows up by default. You can change your Home page by going into the Internet Options command and then entering the URL for you new home page on the General tab. That takes too many clicks! Try this instead: go to the Web site you want to be your new home page. Once you're there, click the icon in the Address bar just to the left of the URL and drag it to the homepage icon on the button bar. When you let go, a Home Page dialog box will appear asking if you want to make the site your new home page. Click Yes. Bingo! You now have a new home page. 

How to Print to Network Printer from an MS-DOS-Based Program

DOS is not dead! There are plenty of offices out there that still use DOS-based applications. These offices often need to print from these applications from their Windows XP computers. How can you do this? It's pretty easy when you know how! Check out this article to find out how to set up your Windows XP machine to print from DOS applications:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q314499
How to Backup Outlook Express Messages and Windows Address Book

Your email messages are probably the most important data you keep on your computer. The worst computing disaster most people experience is the loss of their email. Here's some easy steps you can take to back up your messages and address book: 

1. Right click on the Desktop, point to New and then click Folder. Rename the folder to My Backup Files. 

2. Click Start and then click Search. In the What do you want to search for? balloon, click on the All files and folders arrow. 

3. In the Look In box, click Local Hard Drives. 

4. In the Named box, type *.dbx, and then click Search. When the search is completed, you should see a list of all the files with the .dbx file extension in the Search Results window. 

5. Click the Edit menu and then click the Select All command. 

6. Click the Edit menu and then click the Copy command. 

7. On your desktop, double-click the My Backup Files folder. 

8. On the Edit menu, click Paste. 

Repeat steps 4 through 9, but this time search for files with the *.wab file extension. Those files will be for the Windows Address Book.

How to Restore Backed Up Outlook Express Message Files

1. Open the Windows Explorer and create a folder on the C: drive called MailFiles. 

2. Copy the .dbx and .wab files you backed up into the MailFiles folder you created on the C: drive 

3. Open Outlook Express. Click on the Tools menu and then click the Options command. 

4. In the Options dialog box, click on the Maintenance tab. On the Maintenance tab, click on the Store Folder button. 

5. The Store Location dialog box appears. Click the Change button in the Store Location dialog box. 

6. The Browse for Folder dialog box appears. Make sure the C: drive is expanded and then click on the MailFiles folder. Click OK, then click OK in the Store Location dialog box. A dialog box appears asking you if you want to switch the store location. Click Yes. Note that you need to switch your store as soon as you start using the new Outlook Express, as the old message store will replace the current one. Since you're starting with a new Outlook Express, you don't have to worry about losing any messages. 

7. Click OK in the dialog box that tells you the store location won't be changed until you restart Outlook Express. 

8. Click OK in the Options dialog box. 

9. Close Outlook Express and then open it again. You'll now see your old messages. 

10. Now let's get your address book back. In Outlook Express, click the File menu and then point to Import. Click on the Address Book command. 

11. In the Select Address Book File to Import from dialog box, navigate to your MailFiles folder and click on the .wab file in that folder. Click Open. Click OK in the dialog box that tells you the import completed successfully.
Disable Messenger in XP

Start - execute : c:\windows\inf\sysoc.inf

Rechercher le mot suivant : msmsgs

Dans la ligne "msmsgs=msgrocm.dll,OcEntry,msmsgs.inf,hide,7"

Effacer hide pour la ligne soit : " msmsgs=msgrocm.dll,OcEntry,msmsgs.inf,,7"
Enregistrer - fermer.

Aller dans ajout/suppression composants Windows. Supprimer Messenger

(Source SVM avril 2002 p153)

Whacking Windows Messenger 

Each and every week, WinXPnews readers plead with us to help them whack the Windows Messenger. We don't blame them! That thing creates far more problems than it solves, and we suspected it was a culprit in preventing one of our laptops from shutting down correctly. Luckily, it's easy to keep the dreaded thing from coming back - if you know what to do: 

1. First, right click the Messenger icon in the system tray and click Exit. 

2. Right click the Start button and click the Explore command to open the Windows Explorer. 

3. In the Windows Explorer, expand the Program Files folder on the partition where your operating system is installed (the partition that holds the WINDOWS directory) and right click the Messenger folder and select Rename. 

4. Rename the folder to MessengerDISABLED and press ENTER to commit the name change. 

5. Restart the Computer. No more Windows Messenger! Cool. 

How to Prevent Messenger from Running on a Windows XP-Based Computer

If you're running a corporate network, or even a small business network, you probably know that Instant Messengers are the ideal vehicle for spreading Internet viruses and worms to your network! Who needs that? Microsoft has heard the wailing and gnashing of teeth related to Windows Messenger problems and now has an official document to help you permanently whack the Messenger. Head on over to the link below and use the method that applies to your operating system and Messenger version

http://support.microsoft.com/default.aspx?scid=kb;en-us;302089
Disable Windows Messenger Service Spam

Click Start and then click Control Panel. 

In the Control Panel, make sure you're in Classic View. Open the Administrative Tools applet. 

In the Administrative Tools window, click on the Standard tab. Now find the "Messenger" entry and double click on it. 

Click the down-arrow in the Startup type drop down list box and select the Disabled command. Click the Stop button. After the service stops, click OK. Now you won't get anymore Messenger spam, and when you restart the computer, the Messenger service won't start automatically
Disable "Send error report message"
Nevertheless, many users are not comfortable with sending off a message to the "mothership" each time they experience a problem and are annoyed with having to click the "Do not send" button every time to prevent it. The good news is that you can turn off this error reporting "feature" if you want: right click My Computer, select Properties, select Advanced, select Error Reporting and check the Disable error reporting box.

Your Account Is Locked Out When You View an FTP Server with IE6

Most of us like to use IExplorer to connect to FTP sites. But if you connect to password protected FTP sites, you've probably noticed that you get locked out if you go to sites that have many levels of folders in the hierarchy. The problem is that IE doesn't remember your password, so it doesn't resend it. So, after trying to connect to a certain number of folders, the user account can get locked out! For more info.on this problem and instructions on how to get a fix check out:

http://support.microsoft.com/default.aspx?scid=kb;en-us;326728
How to Use Remote Desktop to Connect to a Computer on Your Network

The Remote Desktop feature provides one of the most compelling reasons to get Windows XP Professional. If you run a small office or home office, you might have two or three computers, with your main computer running Windows XP. Maybe you have a laptop and a desktop, with the laptop running Windows 98 or Windows ME. Wouldn't it be nice to see your Windows XP desktop computer on your wireless laptop? You bet! Here's how: 

On the machine to which you want to connect over the network, click Start and click Control Panel. Make sure the Control Panel is in classic mode and then click the System icon. 

Click on the Remote tab in the System Properties dialog box. Put a checkmark in the Allow users to connect remotely to this computer checkbox. Click on the Select Remote Users button and make sure your user account is included on the list. Click Apply and then click OK. Be sure to leave this computer running so that you can connect to it from another computer over the network. You can make your computer secure while it's still running by pressing CTRL-ALT-DEL and locking it. 

Go to the other computer that you want to use to connect to the Windows XP computer. If the other computer is running Windows XP, you can skip this step. Put in your Windows XP CD-ROM (your vendor did give you your CD, right?). The CD will autorun and you'll see the option Perform additional tasks. Click that option. On the next screen, you'll be asked what you want to do. Click Setup Remote Desktop Connection. This will start the installation Wizard. Finish the installation and go to the next step. 

Click Start, point to Programs or All Programs (depending on your operating system), point to Accessories, point to Communications and click on Remote Desktop Connection. In the Remote Desktop Connection dialog box, type in the name (or IP address) of the computer to which you want to connect and click Connect. 

You'll need to log on after making the connection. Log on and work just as you would if you were right in front of the XP computer. You can run programs installed on the XP machine, even if you don't have those programs on the computer you're using. All processing is actually done on the XP computer. When you're done, log off as you usually do. No one else will be able to use the XP computer while you're logged on to it, so you don't have to worry about someone trying to "share" the computer :)
Enabling Remote Desktop for Internet Use 

Remote Desktop can be an absolute life saver when you're on the road. We were stuck in a hotel with a wireless network that didn't allow outbound VPN connections, but they did allow outbound Remote Desktop connections. I was able to connect to my Windows XP desktop, access my files, and work just as if I was at home. It's great! However, you need to enable Remote Desktop on your home computer before you leave, and then configure your Internet Router to support connections through the Internet. Here are some tips and tricks: 

1. The first thing you need to do is enable Remote Desktop connections to your PC. Click Start and then right click My Computer. Click the Properties command. 

2. Click on the Remote tab in the System Properties dialog box. 

3. On the Remote tab, put a checkmark in the Allow users to connect remotely to this computer checkbox. You may see a dialog box warning you that some accounts do not have passwords and that only accounts with passwords will be able to connect. Click OK to close the dialog box. 

4. Click on the Select Remote Users button. Note that the Administrator account already has access, and that any member of the Administrators group can connect, even if you don't manually add them. Click the Add button. Type in the name of the user account you want to use to access the Remote Desktop, then click the Check Names button to make sure you typed it in correctly. Click OK after adding the name. 

5. Click OK in the Remote Desktop Users dialog box. 

6. Click Apply and then click OK in the System Properties dialog box. 

7. The last step is the trickiest, because the steps are different depending on what type of "router" you use to connect to the Internet. What you need to do is configure your "router" (it's actually a NAT server in most cases, rather than a true router) to allow incoming Remote Desktop connections to the external IP address of the router to be forwarded (sent to) the IP address of your Remote Desktop Windows XP computer. The "router" or NAT server needs to pass all incoming connections to TCP Port 3389 to your Windows XP computer. The challenge is getting your Internet connection device to pass the Remote Desktop connections to your computer. Also, make sure you have a strong password on your computer, as it's exposed to the Internet. 

Switching from XP (simple) to "Normal" Sharing mode

Pour changer du mode standard (simple) à normal pour les shares (droits, permissions) Menu Tools - Folder Options - View - et tout en bas décocher "Use simple file sharing (recommended)"
Configuring DHCP or Static IP From the Command Line:  netsh

netsh is a pretty useful command-line tool that lets you control tons of things about your network interfaces and services.  One really neat thing that netsh will do for you is to let you set IP addresses, DNS and WINS servers.  It works on Windows 2000, XP and .NET Server.

Suppose I have a laptop that travels between an office in Washington, DC, and an office in Los Angeles.  The DC office uses DHCP.  The LA office uses static IP addresses and when it's there, the laptop is supposed to use IP address 192.168.2.10, subnet mask 255.255.255.0, WINS server 192.168.1.100, DNS server 192.168.1.100.

First, I'll build the DC batch file.  I'll need three commands.  One tells my system to get its IP address from DHCP, the next says to get its DNS server from DHCP, and finally the third says to get its WINS server from DHCP.  They look like this:

netsh int ip set address local source=dhcp

netsh int ip set dns local source=dhcp

netsh int ip set wins local source=dhcp

These are the simpler commands.  I just open up Notepad, type them in, and save the file somewhere on my system's path as dodc.cmd.

"netsh int ip set" is the starting point for every one of these commands.  "netsh" is the overall command, and it does lots and lots of things.  But to modify the behavior of a particular network interface, I use the subcommand "int," which is short for "interface."  Within that, I could do several things, but in the particular case I want to change the IP settings, hence the IP, and I want to change ("set") those settings rather than display them, so I use "set" instead of "show."  By the way, netsh will always give you help if you ask it.  Just type "netsh" all by itself and your prompt will change from "C:\>" or whatever to "netsh>;" you can then type "?" to find out what commands netsh will accept, one of which would be "int."  If you then typed "int" then the prompt would change to "netsh interface>," and a "?" would tell you that "IP" was one option, and so on.

The three commands pretty much won't vary from one system to another unless you've got more than one NIC.  If you've got more than one NIC, then you'll want to tell netsh which NIC you're trying to configure.  In that case, replace the word "local" with the NIC's name in quotes, as in

netsh int ip set address "Local Area Connection 2" source=dhcp

Next, I'll tackle the LA batch file.  I want to set the IP address to 192.168.2.10 with a subnet mask of 255.255.255.0 and a default gateway of 192.168.2.1.  That command looks like this:

netsh int ip set address local static 192.168.2.10 255.255.255.0 192.168.2.1 2

It starts with "netsh int ip set address local" as before, but now instead of "source=dhcp" I specify "static," meaning that it's a static IP address.  The three four-quad values following are, of course, the IP address, subnet mask, and default gateway.  The "2" at the end is the metric for the default gateway.  As it's at least one hop away from anywhere in the Internet, I specified "2," but you could set it to anything that makes sense.

Next, I'll set the DNS server to 192.168.1.100.  That command looks like this:

netsh int ip set dns local static 192.168.1.100 primary

Again, the "static" parameter says that we're specifying a value rather than using DHCP.  The IP address is of course the IP address of the DNS server, and "primary" says to do a dynamic DNS registration on the primary DNS suffix.  The alternative to "primary" is "none," which says not to do any dynamic DNS registrations, or "both," which means to register on all DNS suffixes.

The command to set a WINS server is similar:

netsh int ip set wins local static 192.168.1.100

Just like the DNS command, except without the primary/none/both option.  Collecting the commands together, we get doLA.cmd:

netsh int ip set address local static 192.168.2.10 255.255.255.0 192.168.2.1 2

netsh int ip set dns local static 192.168.1.100 primary

netsh int ip set wins local static 192.168.1.100

Adjusting the Windows XP DNS Negative Cache Settings

Here's a problem you never had to deal with when working with Windows 9x/ME. Windows XP and Windows 2000 have a special feature that allows them to connect to Internet servers faster. This feature, called the "client side DNS cache" allows your computer to keep a list of IP addresses for Internet web sites you've successfully contacted in the last 24 hours. However, this client side cache also does something called "negative caching". The negative caching feature allows the client side cache to remember that it wasn't able to find the IP address of an Internet computer. This negative caching can be very helpful at times, but it often creates more problems than it solves. Here's a method you can use to disable the client side negative DNS caching: 

Click Start and point to Run. In the Run dialog box, type regedt32 in the Open text box and click OK. Navigate to:

HKEY LOCAL MACHINE \ SYSTEM \ CurrentControlSet \ Services \ Dnscache \ Parameters 

Click the Edit menu, point to New and click DWORD Value. 

Rename the value to NegativeCacheTime. 

Note the default value is zero. That's exactly what you want! 

You should notice a performance improvement for sites that were negatively cached by mistake. It's not something that will jump out and impress you immediately, but I think your Internet browsing should go more smoothly after making this change.
MTU Settings (Max Transmission Unit) Tweaks with Dr TCP
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TCP Receive Window: This is where you set RWIN (RcvWindow). RWIN is the single most important tweak. Raising Rwin from default (8760 for Win95/98/98SE/NT and 17520 for WinME/2K/XP), can greatly improve download speeds. Why? Here is my kindergarten analogy: Default RWIN for broadband, is like having a tiny straw in a thick milk shake, only so much can get through the straw (line), so fast. By putting a larger straw (higher RWIN) in that same thick shake, you allow more shake (data) to come through faster, to a point that is. After which, there is no more improvement, and shake (data) can start spilling all over (packet loss). So the key is, to find an RWIN that fits your line just right. This is blank before changing from default.

The formula for finding your "ideal" RWIN, is to take your latency (average ping time in ms x 1.5), multiply that by your advertised (download) speed, and divide that by 8. 

Note: If setting RWIN below 8192, try using even multiples of MSS. 

Windows Scaling: 65535 is the highest RWIN you can use without Windows Scaling being turned on. So simply put, Scaling is needed to enter any number higher than 65535. However, you must also have the updated vtcp.386 patch (WinME/2K/XP does not need a patch). Relax though, most users do not need to go higher than 65535. Windows Scaling "Defaults" to off (same as No). 

Time Stamping: The need for this seems to be in question, at least with RWIN under 65535. If you have a line where latency varies a lot, or a "long fat pipe" (for example, pure satellite connection), then Time stamping should be beneficial, so experiment with it. Time Stamping "Defaults" to off (same as No). 

Selective Acks: This improves throughput (speed) on lines that tend to lose packets, by re-transmitting only packets that were lost, if any. "Defaults" to on (same as Yes) in Win98/98SE/ME/2K/XP and is N/A in Win95/NT. 

Path MTU Discovery: This automatically sets your MTU (maximum transmission unit) to what type of line you have (dial-up (576), broadband 1492-1500). This is the size of packets that you can receive. The highest MTU that one can have is 1500. For users with PPPoE connection software, 1492 and lower. Without PPPoE, it should default to 1500. "Defaults" to on (same as Yes) in Win98/98SE/ME/2K/XP/NT, and is N/A in Win95. 

Black Hole Detection: This discovers routers on the WEB that cause MTU Discovery to work sub-optimally. "Defaults" to off (same as No) in Win95/98/98SE/ME/2K/XP. 

Max. Duplicate ACKs: This allows for faster re-transmission of packets (information), when packet loss is encountered. "Defaults" to blank, where blank stands for 3 in Win98/98SE/ME, 2 in WinNT/2K/XP, and is N/A in Win95. 

TTL: Time To Live is the amount of hops (servers) that a transmission of packets will take before all packets are lost. If you were receiving packets from 20 hops away, and TTL was set to 19 or less, all packets would be lost before they reach you. Not a speed tweak. "Defaults" to blank, where blank stands for 32 in Win95, 128 in Win98/98SE/ME/2K/XP. 

Adapter settings: This is where you set your MTU. Use the drop-down menu to find your NIC (Ethernet card). If you do not know which adapter you should set, please ask. Do not set them all the same. (Note: If your MTU is 1500 by default, it will be blank in DRTCP. Also: Only physical NIC's supported for XP, no dial-up adapters. 

Note: DRTCP defaults to showing the dial-up adapter. This has nothing to do with the other settings. It does not matter which adapter is visible when setting anything except MTU. Also: Upon reboot the dialup adapter will be showing, regardless of which adapters MTU was set. 

ICS Settings: Internet MTU is set when Internet Connection Sharing (a Microsoft program) is enabled and being used on your PC. This is where 2 or more PCs share the same Internet connection, though only one can “surf” at a time. ICS MTU should match that of the PC. This is grayed out if ICS is not being used (not ready for Win2K/XP). 

Also: By right clicking on the logo and choosing "About", you will find information about the version of Windows you use. 

Great, so what should you set all of these to? Most users can leave all of them at Default except for RWIN (surprise!), as this has been determined to be best, most of the time, thus being "Default". After making any changes, click Save, then Exit, then reboot (restart) your PC. Use the Tab button on your keyboard to move about DRTCP. If you do not reboot, the settings will not "take". 

Uninstall: Since DRTCP is a GUI interface (never mind), it is not installed. Therefore there is no uninstall. Right click on DRTCP and choose Delete, if you wish to. 

To simply set your registry back to it's default settings, set everything to "Default" or blank (cleared of value), click Save, and reboot. Done. 

RWIN: How do I raise/lower mine?

Download DrTCP from this page to your desktop. Open it and enter desired value for TCP Receive Window (RWIN). Click Save then Exit and Re-boot your PC so that the change will "take".

How do I restore default settings?

In DrTCP, blank every field. 

Save, exit, and reboot. 

http://www.dslreports.com/faq/578
High Rate of Collisions on 100-Megabit Networks
http://support.microsoft.com/default.aspx?scid=kb;en-us;315237
Allowing VPN Connections to a Windows XP Computer 

Question: I read the article on March 25, 2003 about "Connecting Computers via VPN Over the Internet." My question to you is if it is possible to use a Windows XP computer (a client PC operating system) and make it a VPN server? I thought you would need a VPN server or service from Windows NT/2000/2003 or routers preinstalled with a VPN service. Thanks! -Alex Lu. 

Answer: Hi, Alex! Your Windows XP computer can act as a "mini VPN server". It can accept a single VPN connection (one at a time). You can use just about any version of Windows to connect to your Windows XP mini VPN server. If your Windows XP mini VPN server is not directly connected to the Internet, you'll need to configure the router in front of your Windows XP computer to forward the incoming VPN connections to your Windows XP mini VPN server. Most Internet connection devices ("routers" or NAT servers) allow something called "VPN passthrough" or "PPTP passthrough". You can allow PPTP connections from the Internet to be passed from the Internet (external) IP address on the "router" to the IP address of your Windows XP VPN Server. The setup would look something like this: 
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After configuring your router to forward incoming PPTP connections to your Windows XP computer, all you need to do is set up the VPN client to call the Internet IP address of your router. 

SYSTEM

Les process qui tournent sous XP utilises ou non.

http://www.blackviper.com/WinXP/strangeservice.htm
Speed-up Windows XP Startups 

How to speed up your Windows XP start up times. Just clean out your prefetch folder. Windows XP keeps track of your frequently used programs and sets them up so that they start up faster. However, sometimes a lot of junk gets into the prefetch folder and can slow things down. Try this: 

Open the Windows Explorer and go to c:\WINDOWS\Prefetch folder. 

Click the View menu and then click the Select All command. This should highlight all the files in the folder. Once all the files in the Prefetch folder are selected, press the DELETE key on the keyboard to delete these files. Click Yes to send the files to the Recycle Bin. 

Restart your computer. You should find that Windows XP starts a lot faster! 

Do this once a week and your Windows XP startups will always be snappy. 
Turn System Restore On and Off

Several of you have written in about problems with System Restore. I hear that you either have no system restore points, or you don't have one available that lets you go back a week or two. One reason for this is that you either don't have System Restore enabled for your drives or you aren't dedicating enough space for your system restore points. Here's how you get control over System Restore: 

Click Start and then click Control Panel. 

Switch to Classic View if you're not already there, then open the System applet. 

On the System Properties dialog box, click on the System Restore tab. 

On the System Restore tab, make sure Turn off System Restore on all drives checkbox is unchecked. If it is checked, then you won't be able to use System Restore to get back to where you were when things worked! 

If you want to max out your options, click on a drive letter and click Settings. 

On the Drive Settings dialog box, move the slider bar to the far right towards the max setting. If you need to reclaim some disk space because you're running out of disk space, move the slider bar to the left. Note that if you do this, you reduce the number of restore points you can go back to. 

Click OK and then click OK again. 

If the System Restore was off, restart the computer and now your computer will start recording restore points again.
The Windows XP Automated System Recovery Tool

Windows XP has a best kept secret: the Automated System Recovery Tool. This tool can back up your System Files and create a floppy disk that you can use to restore your system. The ASR only backs up your system configuration, so make sure you use a regular backup method to back up your data files (note that this only works for Windows XP Professional, not for Windows XP Home). 

Click the Start menu and then click the Run command. Type ntbackup in the Open text box and click OK. 

On the Welcome tab of the Backup Utility window, click on the Automated System Recovery Wizard button. 

Click Next on the Welcome to the Automated System Recovery Preparation Wizard page. 

On the Backup Destination page, type in a path for the backup file. Make sure you don't use the C: drive to backup the configuration! For example, we type g:\backup.bkf in the Backup media or file name text box. Click Next. 

Click Finish on the Completing the Automated System Recovery Preparation Wizard page. At this point, the backup program starts backing up the necessary files. This can take a while. 

You'll be asked to insert a blank floppy disk. Put the disk in and click OK. 

The Wizard tells you to remove the diskette and label it. Do so and click OK. Click Close on the Backup Progress dialog box and close the backup utility window.

Be a Temporary Administrator with "RunAs" 

It's a good security practice for administrators to logon with a user account that is not a member of the administrators group, because viruses and worms (and hackers) can take advantage of the fact that you're logged on as an administrator. However, sometimes you need to be an administrator to carry out some specific tasks. Wouldn't it be nice if you could run a task as an administrator without having to logout and log back on again? You can! It's called secondary logon and here's how to use it: 

1. Log on to the computer with an account that is not an administrator. 

2. Click Start and then click Control Panel. 

3. Switch to Classic View. 

4. Right click the Power Options icon. Notice that you have two options: Open and Create Shortcut. Press the Esc key on the keyboard to close the menu. 

5. Hold down the SHIFT key on the keyboard. With the SHIFT key held down, right click the Power Options icon. Click the Run as command. 

6. In the Run As dialog box, select the The following user option. Click the down arrow in the drop down list box and select a user that is an administrator. Type in the account's password and then click OK. Note that this won't work if the account you want to use doesn't have a password. 

7. Bingo! The Power Options Properties dialog box opens under the authority (or "context") of the administrator account you specified. 

Changer de user sans être déconnecté d'internet
HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon

New valeur chaine ( KeepRasConnections  ( valeur 1
You Must Install a Hotfix to Install GPMC on Windows XP Professional 

Here's one for you Windows XP network admins. The Group Policy Management console allows you to do some amazing things with Windows Group Policy. The problem is that you have to install it first - and it won't install with the version of the Gpedit.dll file that comes with XP SP1! This KB article describes the problem and a fix. (WARNING: fix requires XP SP1):

http://support.microsoft.com/default.aspx?scid=kb;en-us;326469
How to use Driver Roll Back to Restore Old Drivers

If you use your Windows XP computer long enough, you'll likely run into a situation where you need to install a new device driver. Device drivers are software pieces that control how hardware talks to the Windows XP operating system. Most device drivers are written very well, but some of them can create havoc after they're installed! One very cool feature included with Windows XP is driver roll back. Windows XP saves copies of old device drivers when you install a new one. If the new driver "drives" your Windows XP computer crazy, you can easily roll back to the old one. Here's how you do it: 

1. Click Start and then click on Control Panel. 

2. Make sure you're in Classic View and then open the System applet. 

3. In the System Properties dialog box, click on the Hardware tab. On the Hardware tab, click on the Device Manager button. 

4. In the Device Manager window, expand the device that's giving you problems. 

5. Right click on the device and click the Properties command. In the device's Properties dialog box, click on the driver tab. On the driver tab, click the Roll Back Driver button. 

6. You may need to restart the computer. Restart the computer if instructed to do so.
Drive Letters Change Unexpectedly When You Install Windows XP
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q326683
Basic Storage Versus Dynamic Storage in Windows XP 

We briefly discussed the issue of Basic vs Dynamic Disks in the editorial, but if you'd like more information about how each type works, here's a nice short article that gives you the "basics" (and the "dynamics"):

http://support.microsoft.com/default.aspx?scid=kb;en-us;314343
Shortcuts to Mapped Drives on W95 or W98 May Not Work in Windows XP

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q330836
Hibernation Problem on Computers with 1 GB of RAM

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q330909
Hard Disk May Become Corrupted When Entering Standby or Hibernation

Those giant hard disks that are larger than 137 GB are a lot of fun. You feel as if you can "save" the world - on a single disk. But here's some scary news: Your hard disk might become corrupt when it enters Standby or Hibernation in Windows XP. What's up with that? A small problem with atapi.sys causes the problem. Better head on over and get the fix before you lose your masterpieces!
http://support.microsoft.com/default.aspx?scid=kb;en-us;331958
Stopping Windows XP Services

What's number one on the wish list of most computer users? Faster performance! One thing you can do to improve performance on your Windows XP machine is to stop unused services from running. Each Windows XP service provides some feature that you may or may not need. Many of the default services aren't needed by most computer users. Just do the following to stop these extra services: 

· Click Start and then click Control Panel. 

· Make sure you're in Classic View. If you aren't in Classic View, click the Switch to Classic View link on the left side of the Control Panel window. 

· Double click on the Administrative Tools icon. 

· In the Administrative Tools window, double click on the Services icon. 

· In the Services window, click on the Standard tab (located near the bottom of the Services window). 

· There are many services there; some you need and some you don't. You have to be careful when you stop services because if you stop the wrong ones, things that are important to you might not work any more! You can stop the following services without too much risk: 

1. Alerter 

2. Application Layer Gateway Service (unless the machine is an ICS machine) 

3. Clipbook 

4. FTP Publishing (unless you want to run an FTP server) 

5. IIS Admin (unless you want to run a Web site) 

6. Indexing Service (the built-in indexer doesn't work very well) 

7. IPSEC Services (unless you use IPSec on your network) 

8. Messenger 

9. NetMeeting Remote Desktop Sharing (unless you use this feature) 

10. Smart Card and Smart Card Helper (unless you use Smart Cards) 

11. SSDP Discovery Service 

12. Universal Plug and Play Host (unless you need this to play games on the Internet) 

13. World Wide Web Publishing (unless you're running a Web site)

Double click on the service you want to stop. Click the Stop button. A dialog box will appear and show a clock as the service is being stopped. Then click the down-arrow in the Startup type drop down list box and select Disable. Click Apply and then click OK.

If you find that something you use doesn't work after stopping and disabling a service, you can always go back to the Services window and restart the service, and then change its startup type back as it was before. Alternately, you can use the System Restore feature to get back to where you were before you made the changes.
How to Put an Entire Drive into a Folder

Frank Lund wrote with a great tip on something you can do with Windows XP that you could never do with those old Windows 9x/ME operating systems. This feature, called "Volume Mount Points" (also supported in Windows 2000) allows you to associate an entire partition with a single folder on your hard disk. Frank recommends using the Volume Mount Points feature to free up disk space on a C: drive that's getting too full. If your C: drive is getting too full, you'll love this trick: 

Create an empty folder on your C: drive called "NewDrive". 

Install your new hard disk and open the Disk Management console. You can access Disk Management from the Run command. Type diskmgmt.msc in the Run command and click OK. 

In the Disk Management console, right click on the new disk and click New Volume. Click Next when the Welcome to the New Volume Wizard dialog box appears. 

On the Select Volume Type page, select the Simple option. Click Next. 

On the Select Disks page, make sure the correct disk (the new one) is selected and then type in the size of the partition you want to create. The default is to use the entire disk. Type in the size in the Select the amount of space in MB text box and click Next. 

On the Assign Drive Letter or Path page, select the Mount in the following empty NTFS folder option and then type in the path to the NewDrive folder. Click Next. 

On the Format Volume page, accept the default settings and click Next. Click Finish and the volume will be created and formatted. 

Notice that all the files still appear to be on the C: drive. This makes it easy for you to save all your stuff to the C: drive, but actually use the space on the new disk. 

You can, of course, name the folder whatever you wish instead of NewDrive. 
"Your System Has No Paging File, or the Paging File Is Too Small" Error Message After Windows XP Upgrade

You started your computer after completing the upgrade to Windows XP and you saw the error message above. Yeow! The problem is you have a paging file and that paging file is 2 GBs. What's up with that? Might be that you have a specific Intel chipset. For details and a possible fix check out: http://support.microsoft.com/default.aspx?scid=kb;en-us;316528
Alternative Antivirus Solutions: Escaping Norton Antivirus DRM

Readers have been flooding us with antivirus program solutions that aren't poisoned with DRM. If you're a Norton Antivirus user and want to ensure that your software will work the next time you install it, then check out this list of Antivirus programs that WinXPnews readers recommend: 

	Etrust EZ Antivirus
	 http://www.my-etrust.com 

	Avast32
	 http://www.avast.com/avast32.htm 

	Vexira Antivirus
	 http://www.centralcommand.com/windows_products.html 

	PC-cillin
	 http://www.winxpnews.com/rd/rd.cfm?id=030304SE-PC-cillin 

	Sophos Antivirus
	 http://www.sophos.com 

	F-Secure Antivirus
	 http://www.f-secure.com/products/anti-virus/workstations 

	Panda Antivirus
	 http://www.pandasoftware.com 

	AVG
	 http://www.grisoft.com 

	NOD32
	 http://www.nod32.com/home/home.htm 

	Protector Plus
	 http://www.protectorplus.com 

	Command Antivirus
	 http://www.commandsoftware.com/products/soho.cfm 

	Kaspersky Antivirus
	 http://www.kaspersky.com 

	AntiVir Personal Edition
	 http://www.free-av.com/main.htm


How to Move the Printer "Spool" Folder in Windows XP

Do you have problems when printing large documents? Maybe you have a 200 page report that's heavy with graphics and charts and you can never get the thing to print. Or maybe you have problems with very slow printing and print hang-ups, even for small files. It might be that you need to change the location of your printer "spool" files. These spool files are created whenever you print something - it's the stuff in the spool file that's actually sent to the printer. If you don't have enough space on the drive your "Windows" folder is located on, you might have crashes when you try to print something. You can get around this problem by changing the location of the spool file. Just do this: 

1. Logon to the computer as Administrator or any other "non-limited" user. 

2. Click the Start button and click the My Computer command. 

3. Create a folder on the drive you want to store the spool files. It doesn't matter what you call it. Just remember where you made it! You can open the drive you want to put the folder in and then click the Make a new folder command in the File and Folder Tasks frame on the left side of the drive window. 

4. Click the Start button and click the Printers and Faxes command. 

5. Click the File menu and click the Server Properties command. 

6. In the Print Server Properties dialog box, click the Advanced tab. 

7. In the Spool folder box, type the complete path to the new folder that you created. For example, if you made a folder called printerspool on the C: drive, type in the path: c:\printerspool. Note that you must type it in correctly and that you don't have the option to browse for the folder. 

8. Click Apply. You'll see dialog box telling you that you shouldn't change the spool folder while printing documents. Click Yes to change the location. 

9. Click OK, and then close the Printers and Faxes folder.
USB 2.0 Device Removed When System Resumes from Hibernation

USB 2.0 is really cool. It's a whole lot faster than the old USB 1.x specification, and it supports all sorts of hardware - external hard disks, cameras, printers, CR-R, DVD-R, you name it! Have you noticed that these cool devices disappear after waking the computer up from hibernation? Ouch! This even happens after installing Windows XP SP1. What's up with that? Not all USB 2.0 devices are affected, but if you have one of them, you'll want the fix. To see if your USB 2.0 device is on the list and how to get the fix check out:

http://support.microsoft.com/default.aspx?scid=kb;en-us;331695
WXP SP1: Default Permissions for Shared Folders Is Read-Only Access for Everyone

When you right click a folder, click the Properties command and click the Sharing tab to share folders, the default setting is to allow Everyone the Full Control permission. It's always been this way and if you used Windows XP, Windows 2000, Windows NT 4.0 or Windows NT 3.x, you're comfortable with how it works. Windows XP SP1 changes this by using a default sharing permission of Everyone Read-only. Not a big deal, but something you should be aware of since it changes the status quo. More info at:

http://support.microsoft.com/default.aspx?scid=kb;en-us;328065
How to Perform an In-Place Upgrade (Reinstallation) of Windows XP 

Is your Windows XP system acting sickly? Maybe things are a lot slower than they used to be, or you just can't get Internet Explorer to work like it did when you got your computer. This article shows you how to reinstall Windows XP and mentions some things to watch out for before and during the installation: http://support.microsoft.com/default.aspx?scid=kb;en-us;315341
How to Manually Start the Uninstall Process to Remove Windows XP

You have the option to uninstall WXP if you upgraded from W98 or WME to WXP. If everything is working OK, you can normally uninstall Windows XP using the Add/Remove Programs applet in the Control Panel (of course, if everything were working okay, you probably wouldn't be wanting to uninstall it in the first place). Sometimes things don't work quite right and you need to manually remove Windows XP from the upgraded machine. The article below describes the procedure. Pay special attention to their warning that you may have to reinstall the operating system. Be careful to back up your data before you go through the manual uninstall:

http://www.winxpnews.com/rd/rd.cfm?id=021203CO-Uninstall_XP 
How to Optimize Clear Type Settings on your Monitor

WXP includes a technology called ClearType that purports to improve the appearance of fonts on LCD and flatscreen desktop displays. Some people even believe it helps the font quality on traditional desktop CRTs. I've always wondered about this because every time I turn on ClearType it feels like I need new glasses because the fonts end up blurry. But many people really love ClearType fonts. If you want to find out if ClearType is for you, then try out the Microsoft ClearType Tuner Web page. It's a safe way for you to check out ClearType and optimize it for your computer: 

Open Internet Explorer and head on over to:

http://www.winxpnews.com/rd/rd.cfm?id=021015HT-ClearType 

Put a checkmark in the Turn on ClearType checkbox. Don't worry about getting stuck with the settings. If you don't like ClearType, you can go back and turn it off. 

Click on the link for Step 2: Tune ClearType Settings. 

On this Web page you're presented with six boxes of text. Click on the box containing the text that looks best to you, then click on the Apply button. The fonts on your display will change based on your selection. If you like the change, you're done! If you don't like the change, click the Back button and choose another box. If you don't like ClearType at all, go back to the first page and remove the checkmark from the Turn on ClearType checkbox.
How to Multiboot XP, 2000, 95, 98, ME and MS-DOS

Hard core Windows tweakers like to run multiple Windows operating systems on the same computer. That makes it easy to run programs that might not run on one operating system but run on another. The problem is you have to install the operating system in a certain way to get them to all play nice together. This article shows you the way:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q217210
Anatomy of a RegWorm (Windows Product Activation/WPA)

Do you live in fear of the day when Windows XP's built-in timebomb will explode on you? That timebomb (WPA or RegWorm) can render your computer useless and require you to get on the phone and beg Microsoft to let you use the computer and software for which you paid big money. What triggers the bomb to explode? Whenever you start your Windows XP computer, the bomb checks on the status of the following hardware devices: 

1. Video adapter 

2. SCSI disk adapter 

3. IDE disk adapter 

4. Network Interface Card (NIC) MAC Address 

5. Amount of RAM 

6. Processor 

7. Processor Serial Number 

8. Hard drives 

9. Hard Drive volume serial number 

10. CD-ROM/CD-RW/ DVD-ROM 

The worm calculates a number associated with the devices and compares it to previous values. You can change up to 6 components in this list during the first 120 days. The bomb is triggered when you change the 7th (at that point you may wish for Linux). The counter is reset every 120 days. At least, that's how it's suppose to work. But keep in mind that software makes errors all the time, so the timebomb might go off even if you haven't changed anything! For a detailed discussion of WPA, check out: http://www.aumha.org/a/wpa.htm
Certain Programs Do Not Work Correctly If You Log On Using a Limited User Account

Have your limited users experienced the following kinds of problems when running certain programs on their Windows XP computers? 

Program does not run. 

Program stops responding (hangs). 

Receive notification of run-time error 7 or run-time error 3446. 

Program does not recognize that a CD-ROM is in the CD-ROM drive. 

Program does not allow you to save files. 

Program does not allow you to open files. 

Program does not allow you to edit files. 

Program displays a blank error message. 

You cannot remove the program. 

You cannot open the Help file 

The problem is that some programs just don't work correctly when using a limited user account. For a BIG list of programs that don't work, and workarounds for the problem check out: http://support.microsoft.com/default.aspx?scid=kb;en-us;307091
AUTRES
Using the Same Computer at Home and Work

Many users use the same laptop at home and at work. There are challenges to making this work because you have to use different accounts to access the home network and the corporate network domain. Donald Nientker shares a solution that works for him: 

"After I had to reinstall XP, I accidentally found out the following 'trick': Set the computer up for 'on the road' and for use on the network. Then, while being connected to the network, log on using the 'on the road' logon. In the Windows Explorer you can then click Tools, Map network Drive and enter drive directory (\\server\dir) and the domain. You are asked for Username and Password once and after that, every time I plug the network cable in, I have access to the network without having to switch the user. Following this, I disabled the logon window in Control Panel, User accounts, Change the way users log on or off. Now I don't have to log on, whether on the road or in the office and don't have to worry about different user accounts." 

Quake Coughs a Hairball in Windows XP

A few of you have written in about problems running Quake in Windows XP. You're playing the game, or about to play a game, and the program just quits! Turns out there is a small problem with Windows XP that causes Quake to quit. The good news is that Microsoft has a fix for you! Click on the link below and get the Application Compatibility update. Quake will play fine after the fix.

http://www.winxpnews.com/rd/rd.cfm?id=021022UP-Quake 
DRM

It restricts your use of media you've bought access to, taking away your rights to play your legally purchased mp3 on your portable device or burn it to a CD, copy an ebook you've bought into a plaintext file for use with a text-to-speech program, or any other of a large number of legal activities. As such, it is better referred to as Digital Restrictions Management, as the purchaser's rights aren't being protected, but rather restricted. Let's take the marketing spin away from the technology, and make sure we call it what it is.
Desktop, everyday use
Make the Status Bar "stick" in Windows Explorer 

The "status bar" is a small area on the bottom of a window where information about a folder or a drive appears. Many WinXPnews readers have said that the status bar vanishes after they enable it. Here's a way to make that status bar stay put and appear in all folders: 

1. Right click on the Start menu and click the Explore command. 

2. In the Windows Explorer, click the View menu and then click the Status Bar command. 

3. Click the Tools menu and then click the Folder Options command. 

4. In the Folder Options dialog box, click on the View tab. Click on the Apply to All Folders button. Click Yes in the dialog box that informs you that the changes will occur the next time you open other folders. 

5. Click OK in the Folder Options dialog box. 

6. Open the My Documents folder. Notice the status bar? It'll be in all your folders now. 
Quick Way to Access Your Drives in the Windows XP Explorer 

A lot of you don't like the way the Windows Explorer opens up to the My Documents folder by default. A couple of weeks ago we showed you how to get the Windows Explorer to open up to your C: drive by making a change in the shortcut. Randall Weers reminded us of an even better way to get the Windows Explorer to open up and show your drives. If you have a keyboard that has a "Windows key", just hold down the Windows key and press the letter E on the keyboard. Pow! The Windows Explorer opens and shows all your drives. Great! 

Make the Mouse Pointer Disappear When You Type

If you spend even a little time typing out emails and word processing documents, you've noticed that darn mouse pointer can get in the way of the text. Sure, you can move your hands from the keyboard and move the pointer, but wouldn't it be nice if you could just have the pointer disappear while you type? You bet! Here's how: 

Click Start and then click on Control Panel 

Make sure you're in Classic View and open the Mouse applet 

In the Mouse Properties dialog box, put a checkmark in the Hide pointer while typing checkbox 

Click Apply and then click OK 

Now the mouse pointer disappears while you type!
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